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VISION 

   The Computer Science & Engineering aims at providing continuously stimulating educational environment to its 
students for attaining their professional goals and meet the global challenges. 

 

MISSION 

1. To develop a strong theoretical and practical background across the computer science discipline with an 
emphasis on problem solving. 
 

2. To inculcate professional behavior with strong ethical values, leadership qualities, innovative thinking and 
analytical abilities into the student. 
 

3. Expose the students to cutting edge technologies which enhance their employability and knowledge. 
 

4. Facilitate the faculty to keep track of latest developments in their research areas and encourage the faculty to 
foster the healthy interaction with industry. 

 

PROGRAM EDUCATIONAL OBJECTIVES (PEOs): 

 

PEO1 Pursue higher education, entrepreneurship and research to compete at global level. 

PEO2 
Design and develop products innovatively in the area of computer science and engineering and in other 
allied fields. 

PEO3 
Function effectively as individuals and as members of a team in the conduct of interdisciplinary projects; 
and even at all the levels with ethics and necessary attitude. 

PEO4 Serve ever-changing needs of the society with a pragmatic perception. 

 
 

        PROGRAM OUTCOMES (POs): 

 

PO1 
Engineering Knowledge 
Apply knowledge of mathematics, science, engineering fundamentals, and specialized engineering 
knowledge to solve complex engineering problems. 

PO2 
Problem Analysis 
Identify, formulate, review research literature, and analyze complex engineering problems to arrive at 
substantiated conclusions using principles of mathematics, natural sciences, and engineering sciences. 

PO3 

Design and Development of Solutions 
Design solutions for complex engineering problems and develop system components or processes that 
meet specified needs, considering public health and safety, as well as cultural, societal, and 
environmental aspects. 

PO4 
Conduct Investigations of Complex Problems 
Utilize research-based knowledge and methods, including experimental design, data analysis, 
interpretation, and information synthesis, to draw valid conclusions. 
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PO5 
Modern Tool Usage 
Create, select, and apply appropriate techniques, resources, and modern engineering and IT tools, 
including predictive modeling, to complex engineering activities while understanding their limitations. 

PO6 
The Engineer and Society 
Apply reasoning informed by contextual knowledge to evaluate societal, health, safety, legal, and 
cultural issues and responsibilities relevant to professional engineering practice. 

PO7 
Environment and Sustainability 
Understand the impact of professional engineering solutions in societal and environmental contexts 
and demonstrate knowledge of the need for sustainable development. 

PO8 
Ethics 
Adhere to ethical principles and commit to professional ethics, responsibilities, and norms of 
engineering practice. 

PO9 
Individual and Teamwork 
Work effectively as an individual, as a member, or as a leader in diverse teams and multidisciplinary 
settings. 

PO10 

Communication 
Communicate effectively on complex engineering activities with the engineering community and 
society at large. This includes writing effective reports, preparing design documentation, delivering 
presentations, and giving or receiving clear instructions. 

PO11 

Project Management and Finance 
Demonstrate knowledge and understanding of engineering and management principles and apply 
these to one’s work as an individual, team member, or leader to manage projects in multidisciplinary 
environments. 

PO12 
Life-long Learning 
Recognize the need for, and have the ability to engage in independent and lifelong learning in the 
context of technological advancements. 

 
 

PROGRAM SPECIFIC OUTCOMES (PSOs): 

 

PSO1 
The ability to apply Software Engineering practices and strategies in software project development 

using open-source programming environment for the success of Organization 

PSO2 
The ability to design and develop computer programs in networking, web applications and IoT as per 

the society needs 

PSO3 To inculcate an ability to analyze, design and implement database applications 
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Index 

 

 

 

Name of the program Page number Date Signature 

1. To gain familiarity with the basic 
network commands & utilities available in 
the Linux OS. 
 

   

2. To learn about network layer tools and 
analyze captures for congestion.    
3. To learn about queue management 
techniques, and global routing in ns3.    
4. To learn about broadcasting, 
multicasting, and bridging in a Local Area 
Network using ns3. 

   

5. To learn about Wifi and Mobile Adhoc 
topologies with ns3. 

   

6. To introduce Socket Programming in 
TCP and UDP. 

   

7. Observations of Transmission Control 
Protocol (TCP) Connection states, Flags 
and Flow control. 

   

8. To learn Transmission Control Protocol 
(TCP) Flow Control, Error Control, and 
Congestion. 

   

9. To introduce Wireshark &tcpdump, and 
observation of packets in a LAN network. 

   

10. To analyze HTTP packets using 
Wireshark tool, and understand the 
records returned by a DNS server. 
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Experiment-1 

 
Aim: To gain familiarity with the basic ‘networks’ commands & utilities available in the Linux 

OS. 

Some general tips: 
 

● If any command is not installed on your system, do sudo apt-get update on the Terminal 

followed by sudo apt-get install <name>to install it. 

● To see more details about any command, type man <name>on the Terminal. 

● Running <name> -h on your Terminal will display the help menu of that command. 

Procedure: 

Run the following commands on your Terminal window. 

 

1) Troubleshooting  network hosts 

a) ping <address> 

Short for Packet InterNet Groper, the ping command is used to test the ability of your 

computer to reach a specified destination computer. The ping command is usually used as a 

simple way to verify that a computer can communicate over the network with another 

computer or network device. The ping utility is commonly used to check for network errors, 

and works by sending ICMP ECHO_REQUEST to network hosts. 

 

Figure.1. Output of ping command 
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Ping two different machines, one within  India and the other one outside India, and 

observe  the latency. 

Understanding about network interfaces 

b) ifconfig [options] 

ifconfigis used to configure the network interfaces. It is used at boot time to set up 

interfaces as necessary. After that, it is usually only needed when debugging or when 

system tuning is needed. 

 
If no arguments are given, ifconfigdisplays the status of the currently active interfaces. 

Figure.2. The output of “ifconfig” command 

If a single interface argument is given, it displays the status of the given interface only; 

Figure.3. The output displayed on running “ifconfig eth0”
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if a single -a argument is given, it displays the status of all interfaces, even those that are  

down. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure.4. The output displayed on running “ifconfig -a” 
What is the IPv4 address of your computer? 

What is the MAC address/HW address of your NIC card? 
 

c) sudoifconfig eth0 down 

The above command will bring the ethernet interface down, meaning, the system would be 

disconnected from the network. Now, try to ping any network host. What is the observed 

output? 

 

d) sudoifconfig eth0 up 

This command will call DHCP service which is involved in obtaining an IP address. Now, ping 

to any external system. What is the observed output? 

 

e) ifplugstatus 

The ifplugstatus command will tell you whether a cable is plugged into a network interface 

or not. It isn’t installed by default on Ubuntu. Use the following command to install it: 

 
sudo apt-get install ifplugd
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Figure.5. Installing “ifplugd” in Ubuntu system The 

output of ifplugstatus command when the cable is plugged. 

 
 

Figure.6. The output of “ifplugstatus” command 

 

2) Finding all the intermediate network systems 

a) traceroute <address> 

It isn’t installed by default on Ubuntu. Use the following command to install it: 

sudo apt-get install traceroute 

traceroute is a command used to display the  intermediate  nodes through which a packet  

flows from a source location to a destination location. A program capable of doing the same 

in Microsoft Windows is tracert. 

 

 



 

 10 

Figure.7. The output of “traceroute” command 
 

Observe the latency for every hop, IP address of the First hop router, and First hop of your ISP, and 

Total number ISPs which your search explored. 

 

1) DNS tools 

Find the IP addresses of the following machines: 

bits-hyderabad.ac.in 

swd.bits-hyderabad.ac.in 

sites.bits-hyderabad.ac.in 

 

a) nslookup<address> 

nslookupis a program to query Internet domain name servers. nslookup has two modes: 

interactive and noninteractive. Interactive mode allows the user to query name servers for 

information about various hosts and domains or to print a list of hosts in a domain. Non-

interactive mode is used to print just the name and requested information for a host or 

domain. 

 

Figure.8. The output of “nslookup” command
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b) host <address> 

host is a simple utility for performing DNS lookups. It is normally used to convert names to 

IP addresses and vice versa. When no arguments or options are given, host prints a short 

summary of its command line arguments and options. 

 

F
i
g
u
r
e
.
9
.
 The output of “host” command 

c) dig <address> 

domain information groper or dig is a flexible tool for interrogating DNS name servers. It 

performs DNS lookups and displays the answers that are returned from the name server(s)  

that were queried. 
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0
.
 
T
h
e output of “dig” command
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d) DNS Configuration file 

All DNS tools makes use of system DNS configuration file located at /etc directory 

(/etc/resolv.conf). The contents of the file should appear like the below screenshot. 

 

Figure.11. The configuration file “/etc/resolv.conf” 
 

2) Copying files from/to a remote host 

a) scp 

scp allows files to be copied to, from, or between different hosts. 

For example, 

“scpremote_username@remote_host:/home/remote_username/file.txt   /home/your_username” 

will copy the file “file.txt” (located at /home/remote_username) of the remote host 

“remote_host” to your local directory (/home/your_username). 
 
 

To download the tar file (CNLab1.tar) from host 172.16.4.100 to your system, the command is 

sudoscp ipc1@172.16.4.100:/home/ipc1/CNLab1.tar /home/ipc1 

 

Figure.12. Ubuntu Terminal Output 

 
To upload a tar file (2011A7PS111H.tar) from your local directory to a remote directory, the 

command is 

sudoscp /home/ipc1/2011A7PS111H.tar ipc1@172.16.4.100:/home/ipc1 
 

Figure.13. Ubuntu Terminal Output 
 
Now, try to download the folder (/home/ipc1/Lab1) from host 172.16.4.100 to your local PC. Also, 

try to upload your own folder to a remote host. (The folder and all its contents including sub-folders 

should be copied). 
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3) To test the speed of internet connection 

Run the following commands for installing speedtest-cli package. 
 
sudo apt-get install python-pip sudo 

pip install speedtest-cli 

 
After installation, type “speedtest”  in the Terminal and press enter. The output should be similar 

to the figure below. 

 

Figure.14. Ubuntu Terminal Output 
 
 

References: 

 
1. Linux ‘man pages’ available athttp://linux.die.net/man/ 

2. http://www.computerhope.com/ 
http://www.webupd8.org/2014/02/how-to-test-internet-speed-via-command.html 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

http://www.google.com/url?q=http%3A%2F%2Flinux.die.net%2Fman%2F&sa=D&sntz=1&usg=AFQjCNFGMIza-8K_aJ4xqzNICsJjvXMyHg
http://www.google.com/url?q=http%3A%2F%2Fwww.computerhope.com%2F&sa=D&sntz=1&usg=AFQjCNF36_1kuvJiFxBlKXrxZXIhdqfDbQ
http://www.webupd8.org/2014/02/how-to-test-internet-speed-via-command.html
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Experiment-2 

AIM:- To learn about network layer tools and analyze captures for congestion. 

To view routing table entries: 

A routing table, or routing information base (RIB), is a data table stored in a router or a 

networked computer that lists the routes to particular network destinations, and in some cases, 

metrics (distances) associated with those routes. The routing table contains information about the 

topology of the network immediately around it. The construction of routing tables is the primary goal 

of routing protocols. Static routes are entries made in a  

routing table by non­automatic means, which are fixed rather than being the result of some 

network topology "discovery" procedure. 

 

“route” command is used to print, add, delete, edit routes in kernel’s IP routing table. Its 
primary use is to set up static routes to specific hosts or networks via an interface after it has been 
configured with the ifconfig program. When the add or del options are used, route modifies the 
routing tables. Without these options, route displays the current contents of the routing tables.  
 

Tools used: route , ip route 
 

Experiment 1:  
1. Print routing table of your system. Use manual pages to capture observations that follow.  

a. The command is “route”. Type “route” in Ubuntu terminal.  

 
Figure.1.1 “route” output  

 

a) What is the IP address of the default gateway (in your IPC system)?  

b) What does the flags ‘U’ and ‘G’ represent?  

c) What is the metric value for default gateway?  

 

 

 

b. Option “­n” displays all symbolic references in numeric values.  



 

 15 

 
Figure.1.2 “route” numeric output 

 

a) Which route will be taken by a packet with destination address as 172.16.5.128?  
 

c. For faster processing, the routing table is stored in kernel cache. To retrieve table from 

cache, use option “­C”. By default, “route” command shows the table  stored in FIB.  

 

 
Figure.1.3 “route” output from kernel cache  

 

 
Figure.1.4 “route” output from FIB 

 

d. To display all the information in the routing table, use option “ee”.  

 
Figure.1.5 “route” long listing 

a) What are MSS and Window?  
 

e. “netstat” command can also be used to display routing table.  

 
Figure.1.6 “netstat” for displaying routing table 

2. Add a route to the kernel route table  
a. In order to add/delete routes, you should have root privileges. In the below figure, a 

loopback address is added to the route.  
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Figure.1.7 Adding a loopback address 

a) what happens when you add options of “window 6000 mss 1440 irtt 300” to the route 

command in the above figure (note: to ‘add’ the route again,  you must ‘delete’ it 

first as explained in step 3)  

 

b. In the below figure, a route to IP address “192.56.76.0” is added. The next hop is 
interface eth0.  

 
Figure.1.8 Adding “192.56.76.0” as IP address  

 

3. Delete a route in the kernel route table  
a. Delete route for IP address “192.56.76.0” created in step 2b.  

 
Figure.1.9 Delete “192.56.76.0” address from routing table  

b. Delete loopback address route.  

 
Figure.1.10 Delete loopback address 

 

4. Add/Remove a default gateway  
In the below experiment, we will delete the default gateway and re­create it.  

a. Delete the route for default gateway by the following the below figure.  
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Figure.1.11 Delete default gateway 

 

 

b. Use your browser and connect to gmail.com (or any other web­site). There will be a 

connection error because default gateway is unavailable. The above can also be tested 

using a “ping” command as shown below.  

 
      Figure.1.12 ping not working 

 

Add the default gateway back to its original value (172.16.4.1  for IPC1 lab). 

 
Figure.1.13 Adding the default gateway 

 

d. Use your browser and connect to gmail.com (or any other web­site). It should work fine.  
 

Analyse an internal network using Zenmap/nmap: 

Nmap (Network Mapper) is a security scanner used to discover hosts and services on a 

computer network, thus creating a "map" of the network. To accomplish its goal, Nmap sends 

specially crafted packets to the target host and then analyzes the responses.  

The software provides a number of features for probing computer networks, including host 

discovery and service and operating system detection. These features are extensible by scripts that 

provide more advanced service detection,vulnerability detection, and other features. Nmap is also 

capable of adapting to network conditions including latency and congestion during a scan. 

Zenmap is the official Nmap Security Scanner GUI. It is a multi­platform (Linux, Windows, Mac 
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OS X, BSD, etc.) free and open source application which aims to make Nmap easy for beginners to use 
while providing advanced features for experienced Nmap users. Frequently used scans can be saved 
as profiles to make them easy to run repeatedly. A command creator allows interactive creation of 
Nmap command lines. Scan results can be saved and viewed later. Saved scan results can be 
compared with one another to see how they differ. The results of recent scans are stored in a 
searchable database. The topology view in the Zenmap uses many symbols and color conventions.
  

 

Tool used: Zenmap 

 

Experiment 2: 

1. Port Scanning: Performs a port­scan to check for open ports on the specified IP address range  
Open zenmap and give the following details.  

 Target: 172.16.5.0/27  
Command: nmap172.16.5.0/27 

 Click “Scan” button on the top right corner.  
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Figure 2.1: port scan 
a) Can you identify what ports are open on your neighbors’ system?  

 

The below figure shows the network topology for the above scan (Click on the Topology  tab). 
 

 

Figure 2.2: Port scan Topology 
 

a) What is your observation from the above topology?  
 

2. Ping scan: Performs a Ping scan for the specified IP range. It can be used to figure out which 
machines are up and are responding to pings.   
Give the following details in zenmap:  
Target: 172.16.5.0/24  

 Command: choose the ping scan  from the profile dropdown  
Click “Scan” button on the top right corner.  
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Figure 2.3: Ping scan 
3. Traceroute scan: Performs traceroute operation for specified IP addresses  

(experiment with external IP’s ­ say 173.194.36.16/28)  
Give the following details in zenmap:  
Target: 172.16.5.0/24  

 Command: choose the Quick traceroute  from the profile dropdown  
Click “Scan” button on the top right corner.  

 

 

 

 

 

 

 

 

Figure 2.4: Quick Traceroute 
 

 

Figure 2.5: Quick Traceroute Topology 
 

 

4. Intense Scan: Enables OS detection, os version, script scanning and traceroute. This is 
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considered as an “intrusive scan”. Give the following details in zenmap:  

Target: 172.16.5.0/24  
Command: choose the intense scan  from the profile dropdown  Click 
“Scan” button on the top right corner.  

 
Figure 2.6: Intense scan 

 

Figure 2.7: Intense scan Topology 
Basic rule setting in iptables :- iptables is a user space application program that allows a system 

administrator to configure the tables provided by the Linux kernel firewall (implemented as 

different Netfilter modules) and the chains and rules it stores. Different kernel modules and 

programs are currently used for different protocols; iptables applies to IPv4, ip6tables to IPv6, 

arptables to ARP, and  ebtables  to Ethernet frames. iptables requires elevatedprivileges to 

operate and must be executed by user root, otherwise it fails to function. On most Linux 

systems, iptables is installed as /usr/sbin/iptables and documented in its man pages which can 

be opened using man iptables when installed. It may also be found in /sbin/iptables, but since 

iptables is more like a service rather than an "essential binary", the preferred location remains 
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/usr/sbin.  

  Tool used:iptables 

 Experiment 3: 

1. To display firewall rule­set using iptables  
a. Use “­L” option in “iptables” command. By default, “filter” table is displayed.  

 

 

Figure 3.1 Listing firewall rules 
 

b. Explicitly the table can be specified using “­t” option.  
 

 
Figure 3.2 Listing firewall rules (using filter table)  

 

2. To block gmail server, so that, your browser cannot open gmail.com.  
a. Do a nslookup to find the IP addresses of gmail.com  

 

 
Figure 3.3 nslookup for gmail.com  

 

There are two IP addresses associated with gmail.com. Block both the IP addresses.  
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b. Add a firewall rule for outgoing traffic. All TCP packets are not allowed to reach 

internet.  

 

Figure 3.4 Adding a firewall rule 
 

 
Figure 3.5 iptables showing added firewall rule  

 

c. Similarly, add a firewall rule for rest of the IP addresses (Gmail server).  

 

d. Open the browser and connect to gmail.com. What is the observation?  
e. Do a ping to one of the IP addresses of Gmail.com. What is the observation?  
f. Delete the above rules using “­D” option.  

 
Figure 3.6 Delete a firewall rule  

The above command will remove the first rule.  
In a similar fashion, remove all the rules in the OUTPUT chain.  
There is an option “­F” (flush) to remove rule­sets (“iptables ­F”  will remove all the rules).  

 
3. To block all the outgoing packets to gmail.com  

a. Add the firewall rule specified in the figure below.  

 

Figure 3.7 Adding a firewall rule 
 

b. Similarly, add rules for other IP addresses associated with gmail.com.  

c. Do a ping for one of the IP addresses.  
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Figure 3.8 Testing with ping command  

d. Delete the above rules using “­D” option.  

 

Figure 3.9 Delete the firewall rule 
 

The above command will remove the first rule.  
In a similar fashion, remove all the rules in the OUTPUT chain.  
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Experiment-3 
Aim: To learn about queue management techniques, and global routing in ns3 
Study the performance of DropTail and RED queue management techniques: 
 
Tail Drop, or Drop Tail, is a very simple queue management algorithm used by Internet routers, e.g., in  the 
network schedulers, and network switches to decide when to drop packets. In contrast to the more complex 
algorithms like RED and WRED, in Tail Drop the traffic is not differentiated. Each packet is  treated 
identically. With tail drop, when the queue is filled to its maximum capacity, the newly arriving  packets are 
dropped until the queue has enough room to accept incoming traffic. 
The name arises from the effect of the policy on incoming datagrams. Once a queue has been filled,  the 
router begins discarding all additional datagrams, thus dropping the tail of the sequence of  datagrams. 
The loss of datagrams causes the TCP sender to enter slow start, which reduces throughput  in that TCP 
session until the sender begins to receive acknowledgements again and increases its  congestion window. A 
more severe problem occurs when datagrams from multiple TCP connections  are dropped, causing global 
synchronization; i.e., all the involved TCP senders enter slow start. This  happens because, instead of 
discarding many segments from one connection, the router would tend to  discard one segment from 
each connection. 
Random early detection (RED), also known as random early discard or random early drop is an queueing 
discipline for a network scheduler suited for congestion avoidance. RED monitors the  average queue size 
and drops (or marks when used in conjunction with ECN) packets based on  statistical  probabilities. 
If the buffer is almost empty, all incoming packets are accepted. As the  queue grows, the probability for 
dropping an incoming packet grows too. When the buffer is full, the  probability has reached 1 and all 
incoming packets are dropped. 
 
Experiment 1: Compare the performance of DropTail and RED queue techniques 
1. Copy Red_vs_nlred.cc file from examples directory and put all .ccfiles into the scratch folder in ns3. 2. The 
Red_vs_nlred.cc code simulates the following network topology 
 
 
 

 Figure.1. Topology 
3. The bandwidth and delay of the bottleneck link is 1 Mbps and 50 ms. The data rate at the source 
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nodes are higher than 1 Mbps. Since all traffic passes through a single route, there is a congestion in the 
network. This leads to drop in packets. 
 4. Copy the file to ns3_home_folder/scratch/ directory.  
5. Open a terminal and navigate to ns3_home_folder.  
6. Compile ns3 programs using the below command. ./waf 
7. Run red_vs_nlred executable using the following command. ./waf--run Red_vs_nlred--vis  
8. Simulator window will be opened on running the above command. Click “Simulate” button. 
9. Wait for the simulation to complete. Once the simulation is completed, close the window. 
 10.The terminal will show the total no. of bytes received successfully at different destinations. 
 11.Create a new copy of droptail_vs_red.cc and change the queue to RED.  
12.Run the experiment from step.4. to step.10.  
13.Compare and contrast DropTail and RED queue techniques. 
      a. What is the total no. of bytes received in Droptail queue technique?  
      b. What is the total no. of bytes received in RED queue technique?  
      c. What is the inference? 
 

Experiment.2: Performance of RED for different link bandwidths and queue lengths 

 
 

 
For a given network, the following parameters play a critical role in network congestion. 
Traffic characteristics in source/destination hosts  
1. Packet priority = Low, Medium, High 
 2. Traffic Type: Data, Voice, Video 
 3. Application Data Size: Distribution (Constant, Exponential, etc.), Application Data Size (1472 bytes, 512 
bytes, etc.) 
 4. Inter Arrival Time: Distribution (Constant, Exponential, etc.), Mean Inter Arrival Time (micro seconds) 
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Link Properties  
1. Distance (km)  
2. Bit Error Rate (BER)  
3. Physical Medium (CAT510 Mbps, E2, etc.) 
 
 Router properties: 
 1. Buffer size (KB): 8, 16, 32, etc. 
 2. Scheduling Type: FIFO, Priority  
3. Queue Technique: DropTail, RED 
 

Steps in the experiment: 
1. The code simulates the following network topology. 

 
 

                                                 Figure. 2. Topology 
2. The bandwidth and delay of the bottleneck link is 10 Mbps and 10 ms. The traffic at source and destinations 
are 8 Mbps, 5 Mbps, and 7 Mbps. Since, there are many sources passing through a single route (as shown in 
the above figure), there is a huge drop in packets. 
 3. Copy the file to ns3_home_folder/scratch/ directory.  
4. Open a terminal and navigate to ns3_home_folder. 
 5. Compile ns3 programs using the below command. ./waf 
6. Run redqueue executable using the following command ./waf run RedQueueStats vis 
 7. Simulator window will be opened on running the above command. Click “Simulate” button.  
8. Wait for the simulation to complete. Once the simulation is completed, close the window.  
9. The terminal will show the total no. of dropped packets. The following information is displayed. 
    a. Packets drop after crossing avg. threshold level (High prob.)  
   b. Packets drop after crossing max. threshold level (QueueAvg>MaxQueue) 
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   c. Packets drop after crossing the queue length (Queue is full)  
10.Change the bandwidth of the bottleneck link to 15 Mbps. Compile the code and run the experiment. 
    a. What is your observation for step.9  
11.Change the bandwidth of the bottleneck link to 20 Mbps. Compile the code and run the experiment.  
   a. What is your observation for step.9  
12.From the steps 9, 10, and 11 
    a. What is the inference?  
   b. What is the minimum and maximum threshold value?  
13.Change the bandwidth of the bottleneck link to 2 Mbps. Default values of MinThreshold ,MaxThreshold and 
QueueLimit are 5, 15 and 25. Change MinThreshold less than 5 and MaxThreshold less than 15. Compile the 
code and run the experiment.  
   a. What is your observation for step.9 
 

Analyse the effect of broken links on routing table: 
Routing is the process of selecting best paths in a network. In the past, the term routing was also used to 
mean forwarding network traffic among networks. However, this latter function is much better described as 
simply forwarding. Routing is performed for many kinds of networks, including the telephone network (circuit 
switching), electronic data networks (such as the Internet), and transportation networks. 
In packet switching networks, routing directs packet forwarding (the transit of logically addressed network 
packets from their source toward their ultimate destination) through intermediate nodes. Intermediate nodes 
are typically network hardware devices such as routers, bridges, gateways, firewalls, or switches. General 
purpose computers can also forward packets and perform routing, though they are not specialized hardware 
and may suffer from limited performance. The routing process usually directs forwarding on the basis of 
routing tables which maintain a record of the routes to various network destinations. Thus, constructing 
routing tables, which are held in the router's memory, is very important for efficient routing 
When applying link state algorithms, a graphical map of the network is the fundamental data used for each 
node. To produce its map, each node floods the entire network with information about the other nodes it can 
connect to. Each node then independently assembles this information into a map. Using this map, each router 
independently determines the least cost path from itself to every other node using a standard shortest paths 
algorithm such as Dijkstra's algorithm. 
 

 
 
 
Experiment.3: Dynamic Global Routing 
We will examine global routing in a mixed environment with Point to Point links and CSMA/CD channel. 
Copy the dynamic_global_routing.cc file from examples into scratch folder. 
The following topology is created: 
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1. Run the simulation from ns3 home folder 
a. ./waf 
b. ./waf run globalrouting (use ‘vis’ to enable visualization) 
 2. Data is transferred from n1 to n6. Identify n1 and n6 correctly from the visualization.  
3. At presimulation time, global routes configured. Look for the following line in the code: aa  
a.Ipv4GlobalRoutingHelper::PopulateRoutingTables ();  
4. The shortest path from n1 to n6 is via the direct pointtopoint link. This will be the default choice. 
 5. At time 1s, CBR traffic flow from n1 to n6 is started  
6. At time 2s,the n1 pointtopoint interface goes down. Through what path will the packets get diverted?  
   a. Under what other circumstances (apart from the interface going down) could the path of the packets 
dynamically change?  
7. At time 4s, the n1/n6 interface is reenabled to up. Now what will be the path taken by the packets between 
n1n6?  
8. At time 6s, the n6-n1 pointtopoint Ipv4 interface is set to down (note, this keeps the pointtopoint link "up" 
from n1's perspective). Observe the change of path of the packets (NOTE: observe the visualization as well as 
the corresponding pcap files) 
 9. At time 8s, the interface comes up. The older path is restored.  
10.At time 10s, the first flow is stopped.  
11.At time 11s, a new flow started, but to n6's other IP address (the one on the n1/n6 p2p link)  
12.At time 12s, the n1 interface down between n1 and n6 is put down. Packets will be diverted to the 
alternate path  
13.At time 14s, the n1/n6 interface is reenabled. This will change routing back to n1n6 since the interface up 
notification will cause a new local interface route, at higher priority than global routing  
14.At time 20s, the second flow stopped and simulation ends. 
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Experiment-4 
Aim: To learn about broadcasting, multicasting, and bridging in a Local AreaNetwork using 
ns-3. 
First remove old .cc files from your scratch folder. Copy first.cc and second.cc from  
examples->Tutorial into scratch folder. 
Carrier Sense Multiple Access (CSMA) 
Carrier Sense Multiple Access/Collision Detect (CSMA/CD) is the protocol for carrier transmission access in 
Ethernet networks. On Ethernet, any device can try to send a frame at any time. Each device senses whether 
the line is idle and therefore available to be used. If it is, the device begins to transmit its first frame. If another 
device has tried to send at the same time, a collision is said to occur and the frames are discarded. Each device 
then waits a random amount of time and retries until successful in getting its transmission sent. 
Experiment 1: One Point-to-Point link with one CSMA channel with four nodes 
 

 
 

Figure.1. Default LAN Topology 
In p oint2point-csma.cc file you have the topology as given above. This program builds a one point-to-point 
channel from n 0 to one LAN segment over csma channel. But when you run point2point-csma. cc program, 
ns3does not visualize it in the same way. The visualization by ns-3looks like the figure below. 
 

 
Figure.2. Simulation of LAN Topology 

 
In the figure above, the dotted circle in the center is the CSMA channel. The top 

most node is n0. 
 
Pcap captures for the simulation are enabled by default. 
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    1. Do you see ARP communication in the Point-to-Point link? 
    2. What about the CSMA LAN? 
Write down your observations. 
 
For the experiment above, extend it to create the topology given below: 

 
Figure.3. Topology2 

Experiment 2: IP broadcasting over two CSMA channels 
Open the IpBroadcastCSMA.cc file. It uses the following topology: 
 

 
Figure.4. Default Broadcast Topology 

 
In the figure below, n0 is the node in the middle of the two CSMA channels. n0 originates UDP broadcast to 
specified LAN segment. In the IpBroadcastCSMA.cc file, line 101 has OnOffHelper which takes the IP address as 
a parameter. The code given to you has 1 0.1.3.255 as the IP address, which is the broadcast IP of the CSMA 
channel at the bottom in the given figure. If you want n0 to broadcast to both CSMA channels, comment out 
line 101 and uncomment line 103. This will make the broadcast IP as 255.255.255.255 . 
 

 
Figure.5. Simulation of Broadcast Topology 

Write down your observations. 
Experiment 3 : IP multicasting over two CSMA channels 
Open IpMulticastCSMA.cc file. It uses the following topology. 
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Figure.6. Default Multicast Topology 

 
As given in line 101 of the code, n0 is the multicast source 
Ipv4Address multicastSource(“10.1.1.1”) 

This topology is similar to the previous one. n2is the node in the middle of the two CSMA channels. 
 

 
 

Figure.7. Simulation of Multicast Topology 
 
Change the multicast source node to n3 . Send multicast data to nodes n0, n1 , and n4 . 
Write down your observations. 
 
 
 
 
 
Experiment 4: Bridging over CSMA and with one intermediate router 
Open BridgingOneHop.cc file. It uses the following topology. 
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Figure.8. Default Bridging Network 
 
In the figure below, n2 is the router node in the middle. Application data is transmitted from n0 to n1 and 
from n3 to n0. The Data rate for n0>n1 transmission is 500Kb/s (see line 165 of code), and Data rate for n3>n0 
transmission is 100Kb/s (see line 181 of code). 
In the figure below, n2 is the router node in the middle. Application data is transmitted from n0 to n1 and 
from n3 to n0. The Data rate for n0>n1 transmission is 500Kb/s (see line 165 of code), and Data rate for n3>n0 
transmission is 100Kb/s (see line 181 of code) 
 

 
Figure.9. Simulation of Bridging Network 

This shows two broadcast domains, each interconnected by a bridge with a router nodeinterconnecting the 
Layer2 broadcast domains. 
 
While running the simulation, observe the ‘interface statistics’ (right click on the node) for n0 and the bridging 
node n5. Can you observe ‘IPv4 Routing Table’ for the bridging nodes (n5 and n6)? 
 Write down your observations. 
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Figure.10. Observing Node statistics 

 
At n5, we can observe the following statistics: 

 
Figure.11. Statistics for node 5 

 
The Received bytes at interface 1 are maximum. Can you correctly identify interface 1 of node 5 on your 
visualization? Can you identify its interface 2 as well? Why does interface 3 has no Transmitted or Received 
bytes? 
 Write down your observations. 
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Experiment-5 
Aim: To learn about Wi­fi and Mobile Ad­hoc topologies with ns­3. 

IEEE 802.11 wireless LANs use a media access control protocol called Carrier Sense Multiple Access 

with Collision Avoidance (CSMA/CA). 

Wi­Fi systems are half duplex shared media configurations, where all stations transmit and receive 

on the same radio channel. The fundamental problem this creates in a radio system is that a station cannot 

hear while it is sending, and hence it is impossible to detect a collision. Because of this, the developers of 

the 802.11 specifications came up with a collision avoidance mechanism called the Distributed Control 

Function (DCF). 

According to DCF, a Wi­Fi station will transmit only if it thinks the channel is clear. All transmissions 

are acknowledged, so if a station does not receive an acknowledgement, it assumes a collision occurred and 

retries after a random waiting interval. 

 
Experiment 1: 

1. third.cc file in examples folder creates the following topology: 

 

In ns­3, the visualization will appear similar to the figure below: 
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You may increase the number of Wi­fi devices by specifying it at run­time in the following manner: 

./waf ­­run 'wifi­example ­­nWifi=10' ­­vis 

(18 is the hard­coded upper limit) 
You may observe the pcap files generated at different nodes. Packet captures are enabled in the line 

numbers 172­174 of the code: 

pointToPoint.EnablePcapAll ("wifi­p2p"); 

phy.EnablePcap ("wifi­ap", apDevices.Get (0)); 

csma.EnablePcap ("wifi­csma", csmaDevices.Get (0), true); 

 
Since no data applications are enabled, you do not see any data in the pcap files apart from broadcast 

messages by the Wi­fi A.P. In pcap files generated at the A.P., can you observe the beacon frames and 

acknowledgements? 

2. Create a UDP Echo Client­Server application for the above topology. The last node on the CSMA LAN 

should be your Echo Server. Configure any of the Wi­fi devices as your Client. 

Comment out line number 152­166 to implement the above. Observe UDP 

serverport number and other client attributes. 

After running the Echo Client­Server application, observe the fresh pcap files generated. 

 

Experiment 2: Extending the previous topology 

Extend the above topology so as to create a Wi­fi Access Point on one of the CSMA LAN nodes. Connect 

three Wi­fi nodes to this Access Point as shown in the figure below: 

 
 

 
 

Some hints to help you extend the topology: 

● Do not install the Internet stack twice on any node. 

● Remember to give your new Wi­fi Access Point a SSID which is different from the previous one. 

● The Wi­fi devices and their Access Point must be in the same IP subnet. 
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● In order to have your new Wi­fi nodes physically apart from the old nodes, you will need to set 

appropriate values for the SetPositionAllocator method of the MobilityHelper class. 

3. Further, modify your UDP Echo Server­Client application by configuring the Server as a Wi­fi device on 

the new A.P.. (Hint: the present code will not suffice for this implementation  because the Wi­fi devices 

have no ‘IPv4Interface’ associated with them) 

4. The final topology will look like the figure below: 

5.  

6.  
7.  

8. Observe the fresh pcap files generated. You should be able to see data transfer between the two Wi­fi 

devices. 

 

AODV (Ad­hoc On­Demand Distance Vector) 
 
Ad hoc On­Demand Distance Vector (AODV) Routing is a routing protocol for mobile ad hoc networks 

(MANETs) and other wireless ad hoc networks. 

The AODV Routing Protocol uses an on­demand approach for finding routes, that is, a route is established 

only when it is required by a source node for transmitting data packets. It employs destination sequence 

numbers to identify the most recent path. In AODV, the source node and the intermediate nodes store 

the next­hop information corresponding to each flow for data packet transmission. In an on­demand 

routing protocol, the source node floods the RouteRequest packet in the network when a route is not 

available for the desired destination.   It may obtain multiple routes to different destinations from a 

single RouteRequest. The major difference between AODV and other on­demand routing protocols is that 

it uses a destination sequence number (DestSeqNum) to determine an up­to­date path to the 

destination. A node updates its path information only if the DestSeqNum of the current packet received 

is greater  or equal than the last DestSeqNum stored at the node with smaller hopcount. 
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Experiment 3: Understanding the AODV routing protocol for Mobile adhoc networks 
The My_aodv.cc file generates a topology of 12 mobile nodes, 4 in each line. 
 

 
 

 
The nodes are separated by a distance ‘step’ specified in the code. The initial value given to ‘step’ is 100m. 

The step variable can be varied from 80 to 120. As the ‘step’ size increases, you will observe that 

neighboring nodes are not able to communicate to each other directly (the link between then breaks). 

Thus the nodes will use AODV routing to figure out alternate routing paths. Observe the 

aodv.routes file, which gives the AODV routing table at each node. 
 

 
References 

1. http://www.nsnam.org/http://en.wikipedia.org/wiki/Wi­Fi

http://www.nsnam.org/
http://www.nsnam.org/
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Experiment-6 

AIM:-To Introduce Socket Programming in TCP and UDP 

 
TCP Socket Programming:  

A socket is the mechanism that most popular operating systems provide to give programs access  
to the  network. It allows messages to be sent and received between applications  

(unrelated processes)  on different networked machines. The sockets mechanism has  
been created to be independent of any   specific type of network. 

A socket address is the combination of an IP address and a port number, much like one end  
of a telephone connection is the combination of a phone number and a particular extension.  
Based  on this  address, internet sockets deliver incoming data packets to the 
appropriate  process  or  thread.  
 

An Internet socket is characterized by a unique combination of the following:  
1. Local socket address: Local IP address and port number  

2. Remote socket address: Only for established TCP sockets. This is necessary since a TCP server 

 may serve several clients concurrently. The server creates one socket for each client, and 

 these sockets share the same local socket address from the point of view of the TCP server.  

3. Protocol: A transport protocol (e.g., TCP, UDP, raw IP, or others). TCP port 53 and UDP port 

 53 are consequently different, distinct sockets.  

 

Tools used: gedit, terminal  
 

 

Experiment 1: Working of a TCP concurrent server  
 

1. Create “tcp_client.c” and “tcp_server.c”.   

2. Compile server first (as shown below). gcc -o server tcp_server.c 

3. Similarly, compile the client using the following command. gcc -o client tcp_client.c 

4. Run the server using the below command. After running, the server would wait for an  

incoming connection (as shown in the Figure.1)  

./server 
 

 
Fig1. Server waiting for connections 

 

5.On separate terminal window, run the client using   
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./client <server IP or localhost> 

 

Fig2. Client waiting for User input 

6.Enter a character as input and it will be echoed back by the server (Refer Figure.3)  

 

Fig3. Client input-output 

 

 

Fig4. Server output 

 

7.To stop the server and client, click “Ctrl +C” in their respective terminals. (To start the server again, wait for a 
couple of seconds).  

 

Experiment 2: Modification of the TCP Client-Server programs 
 

1. Download “tcp_client.c” and “tcp_server.c” from the CMS Website  

2. Modify the filenames as “tcp_client_n.c” and “tcp_server_n.c”  

3. Modify the program such that the client sends a string as a message to the server. Make sure the 

server echoes back the same string. (Hint: use buffer to handle the string exchanges by server-client 

and modify read and write functions).  

4. Compile server first (as shown below). gcc -o server_ntcp_server_n.c 

5. Similarly, compile the client using the following command. gcc -o client_ntcp_client_n.c 

6. Run the server using the below command.  

./server_n 
7. The server will start, waiting for a client to connect. On a separate terminal window, run the client 

using   

./client_n <server IP or localhost> 

8. Type “hi I am client!” in the client terminal window. As you see the figure.6, the same message is 

echoed back from the server.  
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Fig5. Client sending string  

 

 

Fig6: Server receiving String  

 

9. To stop the server and client, click “Ctrl +C” in their respective terminals. (To start the server again, 

wait for a couple of seconds).  

 

 

Questions 

Answer the following questions based on your understanding of the experiments.  
1. Which field in the socket function specifies the type of transport layer protocol (like TCP, UDP, etc.)?   

2. What is the IP address and port no. of the server?  

3. What is the purpose of bind function?  

4. Which of the functions mentioned below are blocking calls?  

a. socket  

b. connect  

c. bind  

d. listen  

e. accept  

f. send  

g. recv 

h. close  

      5.    Which function in the client program involved in connection establishment?  

      6.    Which function in the server program involved in connection establishment?  
7. send and recv functions are analogous to writing to a file and reading from a file. (T/F)   

8. What is a concurrent server?  

UDP Socket Programming:  

A datagram socket is a type of connectionless network socket, which is the sending or receiving point 
for packet delivery services. Each packet sent or received on a datagram socket is individually addressed and 
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routed. Multiple packets sent from one machine to another may arrive in any order and might not arrive at 
the receiving computer.  

A datagram socket provides a symmetric data exchange interface without requiring connection 
establishment. Each message carries the destination address.  

Tools used: gedit, terminal  

Experiment 3: Working of an UDP Client-Server program  
 

1. Download “udp_client.c” and “udp _server.c” from the CMS Website.  

2. The programs are partially complete. Complete the rest of the program, so that, it compiles and runs 

successfully (Implement echo server described in Experiment.2.)  

3. Compile server first (as shown below). gcc -o udp_serverudp_server.c 

4. Similarly, compile the client using the following command. gcc -o udp_clientudp_client.c 

5. Run the server using the below command.  

./udp_server 
6. The server will start, waiting for a client to connect. On a separate terminal window, run the client 

using   

./udp_client <server IP or localhost> 

7. Enter a character as input and it will be echoed back by the server (Refer Figure.7)  

 

 

Fig7: Client sending and receiving a character 

8. To stop the server and client, click “Ctrl +C” in their respective terminals. (To start the server again, 

wait for a couple of seconds).  

 

Experiment 4: Modification of the UDP Client-Server programs  
 

1. Download “udp_client.c” and “udp_server.c” from the CMS Website  

2. Modify the filenames as “udp_client_n.c” and “udp_server_n.c”  

3. Modify the program such that the client sends a string as a message to the server. Make sure the 

server echoes back the same string. (Hint: use buffer to handle the string exchanges by server-client 

and modify read and write functions).  

4. Compile server first (as shown below). gcc -o udp_server_nudp_server_n.c 

5. Similarly, compile the client using the following command. gcc -o udp_client_nudp_client_n.c 
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6. Run the server using the below command.  

./udp_server_n 
7. The server will start, waiting for a client to connect. On a separate terminal window, run the client 

using   

./udp_client_n <server IP or localhost> 

8. Type “hello” in the client terminal window. As you see the Figure.8, the same message is echoed back 

from the server.  

 

 

Fig8: Client sending and receiving a string 

 

9. To stop the server and client, click “Ctrl +C” in their respective terminals. (To start the server again, 

wait for a couple of seconds).  

 

Questions 

Answer the following questions based on your understanding of the experiment.  
1. Order the sequence of operations in an UDP socket communication.  

Client functions  Server 

functions  

Close  Close  

Socket  Socket  

Sendto Sendto 

Recvfrom Recvfrom 

 Bind  

 

2. What is the difference between UDP and TCP echo servers?  

References  

➢ Unix Manual: http://man7.org/linux/man-pages/man2/socket.2.html  
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Experiment-7 

Aim: Observations of Transmission Control Protocol (TCP) Connection states, Flags 

and Flow control. 

 

TCP Connection States: 

TCP protocol operations may be divided into three phases. Connections must be properly 

established in a multi-step handshake process (connection establishment) before entering the 

data transfer phase. After data transmission is completed, the connection termination closes 

established virtual circuits and releases all allocated resources. 

 
A TCP connection is managed by an operating system through a programming interface 

that represents the local end-point for communications, the Internet socket. During the  

 
Fig.1: TCP State Diagram 

 
lifetime of a TCP connection the local end-point undergoes a series of state changes: 

 

Tools used: Wireshark, netstat.
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Experiment 1: Observation of TCP connection states 

1. Download “tcp_client.c” and “tcp_server.c” from the CMS Website 

 
2. Compile server first (as shown below). 

gcc -o tcp_servertcp_server.c 
 

3. Similarly, compile the client using the following command. 

gcc -o tcp_clienttcp_client.c 
 

4. Run the server using the below command. 

./tcp_server 
 

5. The server will start, waiting for a client to connect. On a separate terminal window, run the client 
using 

./tcp_client<IP address of your neighbour> 
 

6. Enter a character as input and it will be echoed back by the server. Use netstat to check 

the TCP connection state in client PC and server PC separately. 

a. What is the connection state in the client machine? 

b. What is the connection state in the server machine? 

 
7. Stop client and server programs. Immediately, start the server again. 

a. What is the observation? 
8. Connection Establishment states (LISTEN, SYN_SENT, SYN_RCVD) 

a. LISTEN state 

Start the server in your neighbor PC. 

i. What is the TCP connection state (observed using netstat)? 

 
Fig. 2: LISTEN state on Server side 

9. Connection Termination states 

a. FIN_WAIT2 state and CLOSE_WAIT state 

Server or Client does close (CTRL+C) 

i. What is the connection state in the client machine? 

ii. What is the connection state in the server machine? 
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Fig. 3: FIN_WAIT2 state on Server side (172.16.90.4) 
 

 

 

 

 

 

 

 

 

Fig. 4: CLOSE_WAIT state on Client side (172.16.90.5) 

a).TIME_WAIT 

Connect to the Server with two (or more clients). Stop the server program 

(normal close). Server goes to FIN_WAIT2. Then, terminate your client 

programs. 

i. Now, what is the connection state in the Server machine?  Fig. 5: 

TIME_WAIT state at Server 

b. FIN_WAIT1 

Terminate the server while the client is still receiving data from the server 

(HINT: sending a single character will not give such behavior. You will need to send 

lot more data). FIN_WAIT1 state will observed at server. 
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Fig. 6: FIN_WAIT1 at Server 
2. Reset Connection 

Try sending data to Server when it has been terminated. RST packet is transmitted to client. 

a. Find the RST packet in Wireshark (Refer Figure 7 below) 

 

 

 
F
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g
.
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t from Server (on port 7777) to client (on port 46277) with RST flag set 
 

3. The Use of PUSH Flag 

a. Observe the data packets. Since, the amount of data is too low (1 byte) the TCP 

uses PUSH protocol to send the data. Figure 8 shows the PUSH flag being set in the 

TCP packet (TCP Flags) 
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Fig. 8: Use of PSH to send data 

 

TCP Header Fields: 

The Transmission Control Protocol (TCP) is one of the core protocols of the Internet 

protocol suite (IP), and is so common that the entire suite is often called TCP/IP. TCP provides 

reliable, ordered, error-checked delivery of a stream of octets between programs running on 

computers connected to a local area network, intranet or the public Internet. It resides at the 

transport layer. 

 
Tool used: Wireshark 

 
Experiment 2: Observation of fields in a TCP packet header 

1. Close all the browsers. 

2. Run Wireshark in non-promiscuous mode with root privileges. 

3. Open the websitehttp://lbrce.ac.in/in a browser window. 

4. Stop Wireshark and observe the packets. 

How to differentiate a control packet and a data packet? 
 

5. Connection Establishment packets 

a. Find the SYN packet in the TCP flow. The below diagram (Figure 9, see packet 

number 6) shows the TCP SYN flag set as in a Wireshark window. 

 

 

 

 

 

 

 

 

 

http://www.bits-pilani.ac.in/
http://www.bits-pilani.ac.in/
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Who sends the SYN packet? 

What is the HLEN value for the SYN message? 

 

 

 
 
 
 
 
 
 
 
 
 
 

Fig. 9: SYN/ SYN-ACK /ACK packets 
 

a. Find the SYN-ACK packet in the TCP flow. The above diagram (Figure 9, see packet 

number 7) shows the SYN-ACK packet. 

Who sends the SYN-ACK packet? 
 
Find the first ACK packet from the server (the website). The below diagram (Figure 10) shows the TCP flags as 
in a Wireshark window. 
 

Fig. 10: Data ACKed by Server 
 

a. Check if the last ACK in connection establishment (SYN-SYN ACK-ACK) is piggy 

backed with data packets? 

 
6. Connection Termination packets 

a. Find the FIN packet in the TCP flow. 

http://wiki.wireshark.org/
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b. Find the ACK or FIN-ACK packet from the server (the website). 

c. The below diagram (Figure. 11) shows the TCP FIN flags as in a Wireshark window. 

Fig. 11: Connection termination with FIN flags 
 

1. Urgent flag 

a. In the Wireshark capture of your Client-Server module, find the packet(s) with 

Urgent flag set. (Figure 12) 

 

 
 
 
 
 
 
 
 
 
 
 
 

Fig. 12: URG flag set 
 

2. Source port/Destination Port 

The below figure (Figure. 13) shows the source port and destination port of a packet 

that travels from the web browser to the server. 
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Fig. 13: Source port= 49147, Destination port= 80 
 

a. Does the destination port number change for all packets from a client to a server? 

b. For a given connection, will the source port number change for all packets from a client to a 
server? 

c. What is the source and destination port number of a packet that traverses from 

the server to the client machine? 

3. Sequence Number/Acknowledgement Number 

Observe the sequence number and acknowledgement number in connection establishment 
packets. 

a. Write down the sequence number and acknowledgement number for the following 
packets. 

▪ SYN packet 

▪ SYN-ACK packet 

▪ ACK packet 

       b.What is the value of Window Size in each of the packets in question (a) 

 

1. Round Trip Time Measurement 

a. Go to the SYN packet in the TCP flow. Find the “timestamps” field in TCP Options 

(Refer Figure 14 below). The value of TSecr should be 0. 

 

 

Fig. 14: TSecr value = 0 
 
 
 

b.Go to the SYN-ACK packet in the TCP flow. The “timestamps” field should be similar to the below figure 
(Figure. 15). What is the value of TSecr? 
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Fig. 15: TSecr value for SYN-ACK 
 

The round trip time is calculated based on the receipt of SYN-ACK packet from the server. 

When the client receives the ACK packet, it subtracts the received TSecr from the current 

clock (OS Clock) to obtain the round trip clock difference. 

 
Now, RTT = Round Trip Clock Difference * Clock Period

2. Flow Control 

a. In your Client-Server pcap, can you identify TCP out-of-order packets and TCP Dup ACKs? 
 

 

Fig. 16: TCP DUP ACKs and TCP out of order packets 
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b. Window Size scaling 

 
Fig. 17: Scaling window sizes 

 

 
References 

➢ Unix Manual:http://man7.org/linux/man-pages/man2/socket.2.html 

➢ Wireshark User’s Guide:www.wireshark.org/docs/wsug_html_chunked/ 

➢ Wireshark Wiki Help:wiki.wireshark.org/ 

 
  

http://man7.org/linux/man-pages/man2/socket.2.html
http://www.wireshark.org/docs/wsug_html_chunked/
http://wiki.wireshark.org/


 

 
5
4 

Experiment-8 

Aim: To learn Transmission Control Protocol (TCP) Flow Control, Error Control, and 

Congestion Control. 

 
TCP Flow Control: 

Automatic Repeat reQuest (ARQ), also known as Automatic Repeat Query, is an error-control 

method for data transmission that uses acknowledgements (messages sent by the receiver indicating 

that it has correctly received a data frame or packet) and timeouts (specified periods of time allowed 

to elapse before an acknowledgment is to be received) to achieve reliable data transmission over an 

unreliable service. If the sender does not receive an acknowledgment before the timeout, it usually 

re-transmits the frame/packet until the sender receives an acknowledgment or exceeds a predefined 

number of re-transmissions. 

Selective Repeat is part of the automatic repeat-request (ARQ). With selective repeat, the 

sender sends a number of frames specified by a window size even without the need to wait for 

individual ACK from the receiver as in Go-back N ARQ. However, the receiver sends ACK for each 

frame individually, which is not like cumulative ACK as used with go-back-n. The receiver accepts out-

of-order frames and buffers them. The sender individually retransmits frames that have timed out. 

 
Tools used: Wireshark 

 

Experiment 1: Demonstration of TCP Flow Control techniques 

1. Open capture.pcap file in Wireshark. 

2. Each and every ACK packet should have ACK flag bit set. Check if it is true for all the ACK packets. 

3. A SACK reports a block of bytes that is out of order. Find a couple of packets with SACK 

option set? Write down the sequence number of the packets carrying SACK options? 

4. Identifying zero window size packets (figure above) 

Go to Analyze->Expert Info composite. Under Warnings tab you should be able to see packet 

numbers which had zero Window. 
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To identify zero window and window updates graphically: 

Go to Statistics → IO graphs. For X axis, choose the Tick interval as 0.1 second and Pixels per 

tick as 5. For Y axis, choose Unit as Advanced. Plot graphs for tcp.analysis.zero_window and 

tcp.analysis.window_update as shown above. To generate the graph(s), click on the 'Graph x' 

(x=1,2,...) button at the left. 

Similarly, you can generate a graph to observe TCP full window with zero window and window 
update. 

Modify arguments as shown below: 

 

5. Response time IO Graphs (Inter-arrival time) 

To observe time delay between packets, go to Statistics → IO graphs. For Y axis, choose the 

Unit as Advanced. Generate graph for time delay between packets as shown below. Large spike in the 

graph indicates large delays in time. 
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6. TCP Stream Graphs 

a. Round Trip Time Graph 
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Filter packets going from Server → Client: 

Go to Statistics → TCP stream graphs →Round Trip Time graph 

 

 

In the graph shown below, you can see a spike occurring for RTT. The explanation for this behavior is 

that the graph was obtained for a capture done with the Server on a laptop with a wi-fi connection. 

The Server was deliberately moved away from the wi-fi access point in a zone of weak network 

strength, which led to increased RTT values of the packets. 

 

 

a. Throughput Graph 

Filter packets going from Server-> Client: 

Go to Statistics-> TCP stream graphs->Throughput graph 
 

b. Window Scaling Graph 

Filter packets going from Client->Server: 
Go to Statistics-> TCP stream graphs->Window Scaling Graph 
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For better observations, you may zoom in the graph (Click the middle button on your mouse 

at the area which you want to zoom) 

Window scale factors can be observed in the SYN packets sent from each side at the beginning of the TCP 
flow. 

 

 
 

TCP Error Control: 

There are six important rules that define thegeneration of an acknowledgement. The rules are 

given below. 

 
Tool used: Wireshark 

 
 

Experiment 2: Observation of Error Control in TCP protocol 

a. Rule1: Normal TCP Operation 

b. When end A sends a data segment to end B, it must include (piggyback) an 

acknowledgement that gives the next sequence number it expects to receive. This rule 

decreases the number of segments needed and therefore reduces traffic. 

c. Can you see acknowledgement packets that are piggybacked? 
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2. Rule2: Delayed ACK 

a. When the receiver has no data to send and it receives an in-order segment (with 

expected sequence number) and the previous segment has already been acknowledged, 

the receiver delays sending an ACK segment until another segment arrives or until a 

period of time (normally 500ms) has passed. 

b. We will observe this behavior along with rule 3. 

 

3. Rule3: Preventing unnecessary retransmission of data segments. 

a. When a segment arrives with a sequence number that is expected by the receiver, and 

the previous in-order segment has not been acknowledged, the receiver immediately 

sends an ACK segment. 

b. Find the ACK packets in the pcap file which correspond to delayed ACK (rule 2) and rule 

3. (See the two images below) 
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1. Rule4: Out-of-order sequence numbers 

a. When a segment arrives with an out-of-order sequence number that is higher than 

expected, the receiver immediately sends an ACK segment announcing the sequence 

number of the next expected segment. 

b. Find the out-of-order sequence numbered packets in the pcap file.

http://wiki.wireshark.org/
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2. Rule5: Missing segments 

a. When a missing segment arrives, the receiver sends an ACK segment to announce the 

next sequence number expected. This informs the receiver that segments reported 

missing has been received. 

b. Find the transmission of missing segments in the pcap file (see the last packet in the 

figure below). 

c. Can you see their corresponding ACKs in the pcap file? 

 

 

 

 

1. Rule6: Duplicated segments 

a. If a duplicate segment arrives, the receiver discards the segment, but immediately 

sends an acknowledgment indicating the next in-order segment expected. 

b. Find the transmission of duplicated segments in the pcap file. 

c. Do you see TCP Fast Retransmit happening after Dup ACKs? 
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TCP Congestion Control: 

Congestion can occur when data arrives from a fast network to a slower network. Congestion 

can also occur when multiple input streams arrive at a router whose output capacity is less than the 

sum of the inputs. TCP is mainly used to avoid congestion in the network. To avoid the congestion, 

some of the packets are dropped in the network. This may lead to retransmission of data packets. 

 

Tool used: wireshark, tracepath
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Experiment 3: Demonstration of Congestion Control Techniques in TCP protocol 

1. Congestion control 

In our Client-Server module, congestion can be observed at the Server when multiple clients try 

to connect to it one after another. The figure below explains the fair share behavior of TCP. You can 

make these observations yourself by running a concurrent server and connecting multiple clients to it 

(with some small time difference- say a few seconds). 

 

2. Find Path MTU using Tracepath tool 

 
 
 
 

User-Datagram Protocol (UDP): 

User-Datagram Protocol is a transport layer protocol used by many internet applications. In 

UDP, there is no handshaking between sending and receiving entities. For this reason, UDP is said to   

be connectionless.
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Checksum is the 16-bit one's complement of the one's complement sum of a pseudo header    

of information from the IP header, the UDP header, and the data, padded with zero octets at the end 

(if necessary) to make a multiple of two octets. In other words, all 16-bit words are summed using 

one's complement arithmetic. The sum is then one's complemented to yield the value of the UDP 

checksum field. 

If the checksum calculation results in the value zero (all 16 bits 0) it should be sent as the   

one's complement (all 1s). 

 
Tool used: Wireshark 

 
Experiment 4: Observation of UDP Header fields 

1. Close all the browsers. 

2. Run Wireshark in non-promiscuous mode with root privileges. 

3. Download “udp_client.c” and “udp_server.c” from the CMS Website 

4. Compile server first (as shown below). 

gcc -o udp_serverudp_server.c 

5. Similarly, compile the client using the following 

command. gcc -o udp_clientudp_client.c 

6. Run the server using the below command. 

./udp_server 

7. The server will start, waiting for a client to connect. On a separate terminal window, run the client 
using 

./udp_client 127.0.0.1 

8. Payload size calculation 

a. Observe any UDP packet. The total length of UDP is given by the length of the header 

fields (8 bytes) plus the length of the data (1 bytes in this case). 

Answer the following questions based on your understanding of the above experiment. 

1. What is the source port number? 

2. What is the destination port number? 
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3. What is the total length of the user datagram? 

4. What is the length of the data? 
 

 
References 

➢ Wireshark User’s Guide:www.wireshark.org/docs/wsug_html_chunked/ 

 
  

http://www.wireshark.org/docs/wsug_html_chunked/
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Experiment-9 

Aim: To give an Introduction to Wireshark &tcpdump, and observation of packets in 

a LAN network. 

 
Packet Sniffer: 

The basic tool for observing the messages exchanged between executing protocol entities is called a 

packet sniffer. As the name suggests, a packet sniffer captures (“sniffs”) messages being 

sent/received from/by your computer; it will also typically store and/or display the contents of the 

various protocol fields in these captured messages. A packet sniffer itself is passive. It observes 

messages being sent and received by applications and protocols running on your computer, but 

never sends packets itself. Similarly, received packets are never explicitly addressed to the packet 

sniffer. Instead, a packet sniffer receives a copy of packets that are sent/received from/by 

application and protocols executing on your machine. 

 

 
 

Figure1:PacketSnifferInternalStructure 
 
We will be using the Wireshark packet sniffer [http://www.wireshark.org/] for these labs, allowing 

us to display the contents of messages being sent/received from/by protocols at different levels of 

the protocol stack. (Technically speaking, Wireshark is a packet analyzer that uses a packet capture 

library in your computer). Wireshark is a free network protocol analyzer that runs on Windows, 

Linux/Unix, and Mac computers. It’s an ideal packet analyzer for our labs–it is stable, has a large 

user base and well-documented support includes a user guide.   

(www.wireshark.org/docs/wsug_html_chunked/),manpages(www.wireshark.org/docs/man-

pages/),anda detailed FAQ (www.wireshark.org/faq.html), rich functionality that includes the 

capability to analyze hundreds of protocols, and a well-designed user interface. It operates in 

http://www.wireshark.org/
http://www.wireshark.org/docs/wsug_html_chunked/)
http://www.wireshark.org/docs/man-pages/)
http://www.wireshark.org/docs/man-pages/)
http://www.wireshark.org/faq.html)
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computers using Ethernet, Token-Ring, FDDI, 

serial(PPPandSLIP),802.11wirelessLANs,andATMconnections(iftheOSonwhichit's running allows 

Wireshark to do so). 

 

 

 Figure2:Wireshark Snapshot Ubuntu 
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Experiment1: Introduction to Wireshark 
 

1. Install Wireshark using the following command. If already installed, then please go to 

step2.(One can also install from Ubuntu Software Center). 

 
Sudo apt-get install wireshark 

 
2. OneneedsadministratorprivilegestoworkwithWireshark.RunWiresharkwithsudo privileges 

(Type “sudowireshark” in the Terminal). 

3. Goto Capture->Optionsmenu.Check“eth0” interface and uncheck all other interfaces. 

Uncheck “Use promiscuous mode on all interfaces”. 

4. Do packet capturing by clicking Capture->Start button. Now, the captured packets are 

shown in the center window. Stop capture (Capture->Stop button). 

o What is promiscuous mode of operation? 

 

5. Filters–Therearedisplayfiltersandcapturefilters.Displayfilterscanbeusedonalready captured 

packets. Specify “tcp” in the display filter and press “Apply”. 

o What is the observation? 

6. Capturefiltersisusedtofilteranynewincoming/outgoingpackets.Capturefilterscanbe specified 

in Capture->Options by typing in “Capture Filter” textbox. 

7. Coloring rules–Depending on the protocol(IP,TCP,ARP,etc.)the color of the packet is 

different. These rules can be changed accordingly (View->Coloring Rules…). 

8. Goto capture->interfaces. This will show all the interfaces available in the system. 

o How many interfaces does your system have? 

o Identify the IPaddress of “lo” interface. 

9. Saving the output while capturing: After stopping the capture, do it from File->SaveAs. 

o Open try to open the pcap file in Wireshark. 
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Experiment 2: Introduction to tcpdump 

 
Tcpdump is a common packet analyzer that runs under the command line. It allows the user to intercept and 
display TCP/IP and other packets being transmitted or received over a network to which the computer is 
attached. Distributed under theBSD license, tcpdump is free software. Tcpdump works on most Unix-like 
operating systems: Linux, Solaris, BSD, OS X, HP-UX and AIX among others. In those systems, tcpdump uses the 
libpcap library to capture packets. The port of tcpdump for Windows is called WinDump; it uses WinPcap, the 
Windows port of libpcap. 
 

 
Figure3:tcpdump snapshot 

 
If tcpdump is not already installed, run the below command to install it. 
 
Sudo apt-get update 
Sudo apt-get install tcpdump 
 

1. Run tcpdump (with sudo privileges). Captured packets are displayed in each line (with 

minimal information). 

 
2. Explore the various options in tcpdump 

o –i=>used to specify the interface to listen on(example:-ieth0) 

o –c => used to limit the total number of packets captured (example: -c 100 will 

capture100 packets and will stop) 

o –p=>run in non-promiscuous mode 

o –A=>displays the packets in ASCII format(-XXtodisplayinHEXformat) 

o –D=>lists only the interfaces 

o –w=>capture and write to a file(example:-wsample.pcap) 

o tcp=>capture only TCP packets 
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o port<num>=>capture from a specific port no. 

o src<IP add#> => capture from specified source address. Try to differentiate sent and 

received packets. 

o dst<IP add#> => capture from specified destination address. Try to differentiate sent 
and received packets.
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Experiment3: Observation of packets in a LAN network 

 

 Figure4: A part of the BITS Hyderabad network
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1. Close all browsers. Open a browser window and clear browser cache. 

2. To view arp cache (On your Terminal: arp-a) (It displays MAC addresses, IP addresses, 

interface names). Depending on the subnet, the IP addresses of Cyberoam, default 

gateway, and DNS server will be shown. 

3. Clear your system’s ARP cache(On your Terminal: ipneighflushall) 

4. Put the eth0 interface down using ifconfigdown(as explained in previous lab session) 

5. Launch tcpdump along with ifconfigup(with sudoprivileges). 

o sudoifconfig eth0 up; sudotcpdump -i eth0 c 1000 p w sample.pcap 

o Open a couple of websites in your browser(ex.google.com, yahoo.com) 

o Wait for tcpdump to stop. 

6. Open sample.pcap file in Wireshark. 

7. Observe on Wireshark how your system receives an IP address from the DHCP service. 

Identify the DHCP server’s IP address. 

8. ObservetheARPpacketsbeingsent.IdentifytheIPandMACaddressofyourdefaultgateway. 

9. Observe the DNS query being made to resolve the IP address of the website you 

visited. Identify the DNS server which responded to you. 

10. By observing the packets in Wireshark, identify your own IP address and the IP address of 

the website you visited. 

11. Explore Statistics->Endpoints to identify entities involved in capture. 

o Differentiate for the rnet,IP,TCP,UDP etc., 
 

 

12.ExploreStatistics->Conversations to cover flows(pair of endpoints) 

o Observer different tabs(Ethernet,IP,TCP,UDPetc.). 

o SortondifferentcolumnsinTCP–e.g.Duration,Packets,AddressA,RelStartetc. 
You may also experiment with “FollowStream” button on the popup dialog which adds a Display filter 
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13.Explore Statistics->IOGraph for complete communication, and after filtering for TCP 

communication. 

o Compare two TCP flows–e.g.stream6 and 4 below. 

o Observe the time slider below the graph. 
 
 

 
 
 



 

 
 

76 

 
 

14.ExploreStatistics->FlowGraphtounderstandsequenceofeventsforthefilteredcapture. 

 
 
 
 
References 

❖ WiresharkUser’sGuide:www.wireshark.org/docs/wsug_html_chunked/ 
❖ WiresharkWikiHelp:wiki.wireshark.org/ 

❖ Tcpdumpdocumentation:www.tcpdump.org/#documentation 

 
 
 

http://www.google.com/url?q=http%3A%2F%2Fwww.wireshark.org%2Fdocs%2Fwsug_html_chunked%2F&sa=D&sntz=1&usg=AFQjCNHmIPDZSzqJwe2WL5HhiL7sT8Hw3A
http://www.google.com/url?q=http%3A%2F%2Fwiki.wireshark.org%2F&sa=D&sntz=1&usg=AFQjCNEkoI9Ytw8QqucPhDtudEg1yDY3Ow
http://www.tcpdump.org/#documentation
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Experimet-10 
 

Aim: To analyze HTTP packets using Wireshark tool, and understand 

the records returned by a DNS server. 

 
HTTP (Hypertext Transfer Protocol): 

 
The Hypertext Transfer Protocol (HTTP) is an application protocol for distributed, 

collaborative, hypermedia information systems. It is the foundation of data communication for 

the World Wide Web. Hypertext is structured text that uses logical links (hyperlinks) between 

nodes containing text. HTTP is the protocol to exchange or transfer hypertext. 

 
HTTP functions as a request-response protocol in the client-server computing model. A 

web browser, for example, may be the client and an application running on a computer 

hosting a web site may be the server. The client submits an HTTP request message to the 

server. The server returns a response message to the client. The response contains completion 

status information about the request and may also contain requested content in its message 

body. 

 
Tools used: Wireshark 

 

 
Experiment 1: Working of HTTP 

1. Run Wireshark with sudo privileges. Start capturing in non-promiscuous mode. 

2. Start up your web browser. Next, enter into your browserhttp://timesofindia.indiatimes.com. 

3. Wait until the page is fully loaded. Now, stop the capture. Is your browser running HTTP version 

1.0 or 1.1? What version of HTTP is the server running? (Refer Figure.1.) 
 
 
 
 
 
   
 
 
 
 
 
 
 
 

http://timesofindia.indiatimes.com/
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Figure.1. HTTP Request and Responses



 

 
 

79 

 

4. Type “http” in the display-filter-specification window, so that only captured HTTP 

messages will be displayed later in the packet-listing window. A couple of the 

responses would have a response code of 304 (Not modified). What does the “Last-

Modified” field imply? (Refer Figure.2.) 

 

Figure.2. HTTP Not Modified page 
 

5. Type “http.response.code==200” in the display-filter-specification window. Response 

code of 200 implies that HTTP request got processed successfully and HTTP response is 

sent to the browser window. You can explore different response codes like 304 (not 

modified), 404 (not found) etc. (Refer Figure.3.) 

 
Figure.3. HTTP Response Code 

 
 
 

6. Type “http.cookie” in the display-filter-specification window. 

A cookie is a small piece of data sent from a website and stored in a user's web browser 

while the user is browsing that website. Every time the user loads the website, the 

browser sends the cookie back to the server to notify the website of the user's previous 

activity. (Refer Figure.4.)
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Figure.4. HTTP Cookie 
 

7. Persistent v/s Non-Persistent HTTP connections. Do you see Connection: keep-alive set 

in your packet captures? 

 

8. HTTP proxy set-up (Work in a team of two. First member will install proxy server and 

other will connect from a client) 

i. Install tinyproxy in Ubuntu (In the terminal: sudo apt-get install tinyproxy) 

ii. Open tinyproxy.conf file using vi or gedit (In the terminal: sudo vi /etc/tinyproxy.conf) 

iii. Uncomment the line “Allow 172.16.0.0/12” (Refer the figure below). By this, 

you are allowing anyone on 172.16.xx.yy to connect to your machine. 

Alternatively you may restrict access to one or few machines. To allow access to 

only your client, type the client machine’s IP address (add the following entry in 

the file: Allow <<IP of client>>) if you choose to do this, DO NOT uncomment 

the entry which was specified above. 

iv. Save the file and exit. 
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Figure.5. Tinyproxy configuration file 

 
Now, restart Tinyproxy for the changes to take place. In the terminal: sudo /etc/init.d/tinyproxy stop 
sudo /etc/init.d/tinyproxy start 
 
Default port which is used by Tinyproxy is 8888. 
Do the following on the other teammate’s PC (i.e., the client): 
In Firefox, go to Edit → Preferences →  Advanced tab →Network tab → Click on Settings 
→Check ‘Manual proxy configurations’ →enter IP of proxy server and port (default port is 8888). 
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Figure.6. Firefox Settings 

Now, on your client’s Firefox, connect towww.google.com, and capture packets on Wireshark (i) 

Firstly, when you are connected to the proxy, and (ii) Secondly, without being connected to the 

proxy. What differences do you observe? 

When not connected to proxy, you can see the connection being made with www.google.com 

 
 

Figure.7. Response while not connected to proxy 

 

i. When connected to the proxy, you can only see the proxy server!! (in this case, 

172.26.90.4) 

 
Figure.8. Response while connected to proxy 

 

After you are done with your experiments, it is recommended to stop tinyproxy because if 

you're going to leave Tinyproxy running all the time, it will eventually eat all your memory and 

lock up your server. 

sudo /etc/init.d/Tinyproxy stop 
Before you leave, please remove tinyproxy from your machine so that the next lab’s students 

can have the opportunity to configure it themselves. 

sudo apt-get remove tinyproxy 
 
 

DNS (Domain Name Server): 

The Domain Name System (DNS) is a hierarchical naming system for computers 

participating in the Internet. It associates information with domain names assigned to each of 

the participants. Most importantly, it translates domain names meaningful to humans into the 

numerical (binary) identifiers associated with networking equipment for the purpose of 

http://www.google.com/
http://www.google.com/
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locating and addressing these devices world- wide. 

 
An often-used analogy to explain the Domain Name System is that it serves as the 

phone book for the Internet by translating human-friendly computer hostnames into IP 

addresses. For example, the domain name “www.example.com” translates to the address 

93.184.216.119 (IPv4).  

http://www.example.com/
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Experiment 2: Understanding the records returned by DNS website 

1. Open “network-tools.com/nslook/” in a web browser. This website provides an online 

tool for DNS lookups. 

2. Type “bits-pilani.ac.in” in the domain textbox (as shown in Figure. 9). Click “Go” button. 

http://network-tools.com/nslook/
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Figure.9. DNS Non-authoritative response 
 

o What is displayed in the Answer records? 

o What is the destination port number of the query message? What is the IP 

address to which the query message is sent? 

o How many additional records are found in the DNS response? 

o What are the IP addresses of BITS name servers? 

 
 

3. Type “bits-pilani.ac.in” in the domain (as shown in Figure. 10). Change the server 

address to “202.78.175.200”. Click “Go” button. 

 
Figure.10. DNS Authoritative response 

o What is an authoritative response? 
 

4. Type “root-servers.net” in the domain (as shown in Figure.11.). Click “Go” button. 

o What is displayed in Answer records? 

o What is the total number of root servers? 
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o What is displayed in the Additional records? 

o What is the IPv4 and IPv6 address of a.root-servers.net? 
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                                                Figure.11. DNS Root servers  
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